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Über dieses Dokument

1  Über dieses Dokument

Diese Betriebsanleitung gibt eine Übersicht über die erforderlichen Bedienschritte und Einstellungen 
am Produkt. 

1.1 Bedeutung der Betriebsanleitung

Diese Betriebsanleitung ist Bestandteil des Produkts und Teil des Sicherheitskonzepts des 
Produktes. 

	T Sicherstellen, dass alle Personen, die mit dem Produkt arbeiten, den Inhalt dieser 
Betriebsanleitung vollständig gelesen und auch verstanden haben.

	T Alle Anweisungen, besonders die Sicherheitshinweise, genau einhalten.

Diese Betriebsanleitung enthält wichtige Informationen zur sicheren und sachgerechten 
Bedienung des Produkts.

	T Diese Betriebsanleitung in unmittelbarer Nähe des Produktes für das Personal jederzeit 
zugänglich aufbewahren.

	T Diese Betriebsanleitung an jeden Benutzer, z. B. bei Verleih, oder dem zukünftigen Besitzer des 
Produktes weitergeben.

	T Bei Verlust oder Beschädigung der Betriebsanleitung eine Kopie der Betriebsanleitung auf der 
Homepage von Neutrik (www.neutrik.com) herunterladen.

1.2 Bezeichnungen

Bezeichnung Erklärung

DPRO Adapter Um die Lesbarkeit des Textes zu vereinfachen, wird der DPRO-Adapter 
NA2-IO-DPRO nachfolgend als DPRO-Adapter bezeichnet.

DanteTM audio 
networking

DanteTM audio networking (im Folgenden DanteTM genannt) ist die 
Abkürzung für Digital Audio Network Through Ethernet, wobei es sich 
um ein Audio-Netzwerkprotokoll handelt, das durch die Australische 
Firma Audinate entwickelt wurde. Mit DANTETM werden digitale 
Audiodaten unkomprimiert, mehrkanalig, mit geringer Latenz über ein 
Standard-Ethernet-Netzwerk unter Verwendung von Layer 3 IP-Paketen 
übertragen.

PoE Power over Ethernet bedeutet, dass ein Gerät über den 
Netzwerkanschluss mit Strom versorgt wird.

Peripheriegeräte Alle Geräte, die an den DPRO-Adpater angeschlossen werden können, 
wie Audioquellen (Sender) und Audiosenke (Empfänger)

Audioquelle Alle Geräte, die ein Audiosignal senden

Audiosenke Alle Geräte, die Audiosignale empfangen, wie z. B. Lautsprecher, 
Audiosysteme (Verstärker, Mischpulte usw.)
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1.3 Symbolerklärung

Es wurden einheitliche Sicherheitshinweise, Symbole, Begriffe und Abkürzungen verwendet, um 
diese Betriebsanleitung leichter verständlich zu machen. Mit den folgenden Symbolen sind Hin-
weise gekennzeichnet, die nicht sicherheitsrelevant sind, aber die Betriebsanleitung leichter ver-
ständlich machen.

	OMit diesem Symbol werden die Voraussetzungen für einen Vorgang dargestellt. Die aufgeführten 
Punkte müssen abgeschlossen werden, bevor mit den nachfolgenden Handlungsschritten fortge-
fahren werden kann.

	T Handlungsschritte werden mit diesem Symbol gekennzeichnet. Führen Sie die Handlungsschritte 
in der angegebenen Reihenfolge aus.
	�Das Handlungsergebnis oder die Reaktion des Produkts auf eine Handlung wird mit diesem 
Zeichen dargestellt.

	• Aufzählungen ohne zwingende Reihenfolge sind als Liste mit diesem 
Aufzählungszeichen dargestellt.

1.	Nummerierte Aufzählungen werden auf diese Art dargestellt.
(1) Verweist auf eine Position in einer Abbildung.

Überall, wo dieser Hinweis zu sehen ist, befinden sich nützliche Informationen für einen 
sicheren und störungsfreien Betrieb des Produktes.

1.3.1 Symbole in Abbildungen

Symbol Erklärung

Position in der Abbildung

Nummerierter Handlungsschritt in einer Abbildung.
Die Handlungsschritte in der angegebenen Reihenfolge durchführen.

 Diese Schritte nur ausführen, wenn OS X verwendet wird.

 Diese Schritte nur ausführen, wenn Windows verwendet wird.

1.4 Zielgruppe

Diese Betriebsanleitung richtet sich an Tontechniker sowie an Personal, das umfassende Erfahrung 
im Bereich Ton-/Veranstaltungstechnik hat.

1

1
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2  Sicherheit

2.1 Warnhinweise und Signalwörter

Spezielle Warnhinweise, die auf mögliche Gefahren vor einer bestimmten Handlung warnen, sind 
den Handlungsanweisungen vorangestellt. Die Warnhinweise sind folgendermaßen abgestuft:

	w VORSICHT

Potentielles Gefahrenrisiko!

Diese Art von Warnhinweis warnt vor einer Situation, die zu leichten oder mittelschweren 
Verletzungen führen kann.

	T Bei Missachtung dieses Warnhinweises kann es zu leichten Verletzungen kommen.

	w HINWEIS

Mögliche Gefahr von Sachschäden!

Diese Art von Warnhinweis warnt vor einer Situation, die zu einem Sachschaden am Gerät und 
an dessen Komponenten führen kann.

	T Bei Missachtung des Warnhinweises kann es zu Sachschäden kommen.

2.2 Warnsymbole

Symbol Warnung

Allgemeine Warnung

Warnung vor Gehörschäden

2.3 Wichtige Bestimmungen

Der vorliegende DPRO-Adapter erfüllen die Grenzwertbestimmungen für digitale Geräte der Klasse 
B nach Teil 15 der FCC-Regeln zur Funkentstörung. Ziel dieser Bestimmungen ist es, beim Betrieb 
des Gerätes innerhalb einer Wohnumgebung einen angemessenen Schutz gegen störende Inter-
ferenzen zu gewährleisten. Dieses Gerät erzeugt, verwendet und strahlt möglicherweise Hochfre-
quenzenergie aus und kann, wenn es nicht in Übereinstimmung mit den Anweisungen installiert 
und verwendet wird, Störungen des Funkverkehrs verursachen. Es kann jedoch nicht garantiert 
werden, dass bei bestimmten Installationen keine Störungen auftreten. Wenn dieses Gerät Störun-
gen des Radio- oder Fernsehempfangs verursacht, was durch Ein- und Ausschalten des Geräts 
festgestellt werden kann, sollte der Benutzer versuchen, die Störung durch eine oder mehrere der 
folgenden Maßnahmen zu beheben:

	• Die Empfangsantenne neu ausrichten oder an einem anderen Ort platzieren.
	• Den Abstand zwischen Gerät und Empfänger vergrößern.
	• Das Gerät an eine Steckdose anschließen, die zu einem anderen Stromkreis gehört als der, an 
den der Empfänger angeschlossen ist.

	• Lassen Sie sich durch den Händler oder durch einen erfahrenen Radio- und Fernsehtechniker 
beraten.
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	w HINWEIS

Nicht durch Neutrik ausdrücklich genehmigte Änderungen bzw. Modifikationen an diesem Gerät 
können zum Erlöschen der FCC-Betriebserlaubnis für dieses Gerät führen.

2.3.1 Konformitätserklärung

Das Gerät erfüllt alle relevanten EU-Richtlinien und trägt daher die CE- und EAC-Kennzeichnung. 
Die Konformitätserklärung kann auf www.neutrik.de/de-de/zulassungen-und-zertifikate eingese-
hen werden.

2.4 Wichtige Sicherheitshinweise

Vermeiden Sie Sachschäden am DPRO-Adapter durch ungeeignete Betriebs- und Umge-
bungsbedingungen:

	• Niemals in Wasser tauchen.
	• Vor starker Sonneneinstrahlung schützen.
	• Gerät keinesfalls in unmittelbarer Nähe von Wärmequellen wie Heizkörpern, Heizstrahlern, Öfen/
Herden installieren.

	• Um eine Überhitzung zu vermeiden, das Gerät niemals abdecken.
	• Das Gerät vor Stößen und vor allem vor Stürzen von Ständern, Bühnen, Tischen oder Möbeln 
schützen.

Reparatur

	w HINWEIS

Sachschäden durch unsachgemäße Reparatur!

Der DPRO-Adapter enthält keine Teile, die selbst repariert werden können. Das eigenständige 
Öffnen oder Reparieren kann zu schweren Schäden am Gerät führen.

	T Unter keinen Umständen das Gehäuse des DPRO-Adapters öffnen.
	T Keine Teile selbst auswechseln.
	T Den DPRO-Adapter nur von einem autorisierten Fachhändler reparieren lassen.

Hinweise zum Betrieb
	T Sicherstellen, dass die für den DPRO-Adapter festgelegten Umgebungsbedingungen während 
des Betriebs eingehalten werden.

	T Den DPRO-Adapter nicht verwenden, wenn er nicht ordnungsgemäß funktioniert, 
heruntergefallen, beschädigt oder nass geworden ist oder wenn sich Teile des Adapters unter 
Wasser befunden haben.

	T Wenn während des Betriebs Störungen auftreten, den DPRO-Adapter sofort von Audioquellen 
und/oder Audiosenken trennen.

	T Den DPRO-Adapter nicht in Umgebungen betreiben, in denen entflammbare oder explosive 
Materialien, Gase oder Dämpfe vorliegen oder auftreten können.

2.5 Bestimmungsgemäße Verwendung

Der DPRO-Adapter ist für die Umwandlung eines analogen LINE/MIC-Signals oder eines digitalen 
AES/EBU-Audiosignals in ein DanteTM-Signal bestimmt. Es können ebenfalls DanteTM-Signale in 
analoge LINE-Sinale umgewandelt werden.

2.6 Vorhersehbare Fehlanwendung

Der DPRO-Adapter ist nicht für den Einsatz im Freien und in explosionsgefährdeten Bereichen gee-
ignet.
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Komponenten und Zubehör

1 2

3

4

3  Komponenten und Zubehör

Das Gerät und das Zubehör können separat bestellt werden.

Pos. Beschreibung Artikel-Nr.

1 DPRO Adapter (Gerät) NA2-IO-DPRO

2 Montagehalterungen
(Im Lieferumfang sind 2 Halterungen, 2 Befestigungsschrauben, 2 Torx-Schrauben und 2 
Distanzscheiben enthalten)

NA-MB-KIT

3 Rackblende NRP1RU-2A

4 Abnehmbarer Gummischutz NA-RC

5 Bügelhalterung (im Lieferumfang sind 4 Kreuzschrauben, 4 Befestigungsschrauben, 2 
Sicherungsrahmen, 1 Befestigungsbügel enthalten)

NA-TM-KIT

5



9Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Produktbeschreibung

               

4  Produktbeschreibung

4.1 Was ist der DPRO-Adapter?

Der DPRO-Adapter ist eine Breakout-Box mit 2 Ein- und 2 Ausgängen für den Anschluss älterer 
Audiogeräte an das Dante-Netzwerk. Er verfügt über hochwertige Mikrofonvorverstärker und 2 
Dante-Anschlüsse für einen redundanten Betrieb oder den Betrieb in Reihe. Die Audioparameter 
werden über die DPRO Controller-App eingestellt.

Alle Anschlüsse sind verriegelbar und bieten zusammen mit dem abnehmbaren Gummischutz eine 
zuverlässige Lösung für harte Bühnenbedingungen. Mit optionalen Montagebügeln oder einer 
Rackblende kann die Box unter Tischen, in Bodenkästen, Racks oder am Gerüst montiert werden.

4.2 Gerät

81011 9

1 52 4 63 7

4.3 Anschlüsse und Anzeigen

4.3.1 Vorderansicht

1

2 Pos. Beschreibung

1 Blechgehäuse

2 Gummischutz (abnehmbar)



10 Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Produktbeschreibung

Pos. Beschreibung

1 Signal-LED
Zeigt den Signalstatus an.

	• LED leuchtet grün/gelb/rot: Signal liegt an, 
Farbe zeigt den Signalpegel an, siehe Abschnitt 
"Pegelanzeige" auf Seite 15.

	• LED aus: kein Signal.

2 Phantomspeisung 48V-LED
Zeigt an, ob die Phantomspeisung aktiv ist.

	• LED leuchtet rot: Phantomspeisung aktiv.
	• LED aus: Phantomspeisung nicht aktiv.

3 HPF/Pad LED
Zeigt an, ob HPF oder Pad aktiv ist.

	• LED leuchtet rot: Pad
	• LED leuchtet grün: HPF
	• LED blinkt grün und rot: Pad und HPF aktiv.

4 Ausgang MUTE LED
Zeigt an, ob der Ausgang stummgeschaltet ist.

	• LED leuchtet rot: Stummschaltung aktiv.
	• LED aus: Stummschaltung nicht aktiv.

Pos. Beschreibung

5 System bereit LED
Zeigt den Systemstatus des Geräts an.

	• LED leuchtet rot: System startet.
	• LED leuchtet grün: System ist bereit.

6 Eingangstyp LED 
Zeigt den Status des Geräteeingangs an.

	• LED leuchtet grün: Analoger Modus.
	• LED leuchtet rot: Digitaler Modus.

7 Ausgangstyp LED 
Zeigt den Status des Geräteausgangs an.

	• LED leuchtet grün: Analoger Modus.
	• LED leuchtet rot: Digitaler Modus.

8 Symmetischer XLR Ausgang 2
	• Ausgang für analoge/digitale Line-Signale.

9 Symmetischer XLR Ausgang 1
	• Ausgang nur für analoges Line-Signal.

10 Symmetrischer XLR Eingang 2
	• Eingang für analoge/digitale Line-Signale.

11 Symmetrischer XLR Eingang 1
	• Eingang nur für analoges Line-Signal.

4.3.2 Rückansicht

1 2 3

5 4

Pos. Beschreibung

1 Reset Taste
	• Drücken, um alle eingestellten Parameter zu 
löschen.  
Eine detaillierte Beschreibung befindet sich im 
Abschnitt "5.4.8 Gerät zurücksetzen" auf Seite 
32.

2 Verbindungs-LED
Zeigt den Status der Ethernet-Verbindung an.

	• LED leuchtet rot: Die Ethernet-Verbindung ist 
hergestellt.

	• LED aus: keine Ethernet-Verbindung.

Pos. Beschreibung

3 Aktivitäts-LED
Zeigt den Status der Datenübertragung an.

	• LED blinkt grün: Datenübertragung findet statt.
	• LED aus: keine Datenübertragung.

4 Sekundärer Netzwerkanschluss (RJ45)
Sekundäre Dante®-Schnittstelle/Durchschleifen/
PoE-Eingang (Redundanter Modus für 
eigenständigen redundanten Betrieb, 
Reihenschaltung für Kaskadenbetrieb)

5 Primärer Netzwerkanschluss (RJ45)
Primäre Dante®-Schnittstelle/PoE-Eingang
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4.3.3 Betriebsarten und Schaltlogik des DPRO Adapters

Die schaltbaren Kontakte im DPRO-Adapter funktionieren auf 2 Arten:
	• Bei einem analogen Signal Kanal 1 und Kanal 2 verbinden (gilt für Eingang und Ausgang).
	• Wenn es sich um ein AES-Signal handelt, nur Kanal 2 verbinden (gilt für Eingang und Ausgang).

AES überträgt 2 getrennte Signale über 1 Kabel. Deshalb belegt AES beide Kanäle und Kanal 1 wird inaktiv. Es ist 
nicht möglich, ein analoges Signal auf Kanal 1 und ein AES-Signal auf Kanal 2 zu kombinieren, da dies bedeuten 
würde, dass 3 getrennte Signale vorhanden sind. In diesem Fall hat Kanal 1 Vorrang und es liegt nur das Analog-
signal vor. Dies gilt sowohl für den Eingang als auch für den Ausgang.

Die Betriebsart des Geräts (Analog/AES) wird durch die XLR-Anschlüsse und nicht durch die Software (DPRO-
Controller) festgelegt. Dies kann zu einer Fehlpaarung zwischen den E/A-Anschlüssen des Geräts und den Presets 
im DPRO-Controller führen.

Zum Beispiel:
Ein Preset für einen Analogeingang wird nur geladen, wenn ein Kabel an Eingangskanal 1 angeschlossen ist.

	w VORSICHT

Gefahr von Gehörschäden!

In Folge falscher Anschlüsse können Signalspitzen auftreten.
	T AES/EBU-Signale nicht an Eingang 1 anschließen.
	T Keine Verstärker oder andere analoge Geräte an Ausgang 2 (AES) anschließen, wenn an Ausgang 1 
(ANA) kein Anschluss vorhanden ist.
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4.4 DPRO Controller

Der DPRO Controller ermöglicht die Einstellung von Audioparametern, die Überwachung des Gerätestatus sowie das 
Abrufen, Speichern und Laden von Presets. Die Anwendung ist für PC und Mac verfügbar.

4.4.1 Allgemeine Übersicht

Analoge Ein- und Ausgänge

1

6

5

2

34

Pos. Beschreibung

1 Menü

2 Gerätestatus
Zeigt den Status des ausgewählten Geräts an.

3 Einstellungen für den Ausgang

4 Einstellungen für den Eingang

5 Verbindung zum Dante Controller

6 Verbundene Geräte
Das ausgewählte Gerät wird mit einem grünen Balken auf der linken Seite markiert.
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Menü

Menü Option Tastaturbefehl Beschreibung

File Create Preset Strg/Cmd + N Öffnet ein neues Preset-Fenster.

Preset laden Strg/Cmd + L Wendet den erstellten Preset auf die Geräte an.

Save As Preset Strg/Cmd + S Speichert Presets als .dap-Datei auf dem Computer des 
Benutzers.

Quit Windows: 
Alt + F4, Strg + Q
Mac: Cmd + Q

Beendet die App.

Device Identify Device Strg/Cmd + I Erkennt das ausgewählte Gerät.
Die LEDs auf der Vorderseite des Geräts blinken 10 Sekunden 
lang rot.

Reset Device Löscht alle eingestellten Parameter auf dem ausgewählten 
Gerät.

About Device Öffnet ein Fenster mit allgemeinen Informationen über das 
ausgewählte Gerät.

Network Settings Öffnet ein Fenster mit den Netzwerkeinstellungen.

Firmware Upgrade Öffnet ein Fenster mit Informationen über die Firmware des 
ausgewählten Geräts.

	• Zeigt die Version der installierten Firmware an.
	• Installation des Firmware-Upgrades.

Help About Software Öffnet ein Fenster mit allgemeinen Informationen über die 
DPRO Controller-App und Angaben zum Herausgeber.

Weitere Software-Funktionen/Tastaturbefehle

Option/Funktion Tastaturbefehl Beschreibung

Schieberegler Strg/Cmd + Klick 
auf den Regler

Der Regler springt auf 0.

Gerätestatus
Diese Übersicht zeigt den Gerätestatus an. Die Beschreibung der LEDs finden Sie im Kapitel  
"4.3.1 Vorderansicht" auf Seite 9.

Symbol Beschreibung

Schaltfläche für Geräteerkennung
Auf die Schaltfläche klicken, um das ausgewählte Gerät zu identifizieren.
Die LEDs der XLR-Eingänge und XLR-Ausgänge des Geräts blinken 10 Sekunden lang auf.

Schaltfläche für die Einstellungen
Auf die Schaltfläche klicken, um das Fenster Settings zu öffnen.
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Eingangskanäle

Analoge Eingänge AES-Eingänge: Kanal 1 wird deaktiviert.

Symbol/
Schaltfläche

Beschreibung

Normal Aktiv

Mikrofon/Line-Signal Schaltfläche
Zeigt an, ob das Eingangssignal ein MIC- oder LINE-Signal ist. 
Auf die Schaltfläche klicken, um die Empfindlichkeit zu ändern.
Position MIC: Mikrofonpegel
Position LINE: Line-Pegel

Schaltfläche Tiefpassfilter
Aktiviert den Tiefpassfilter für das Eingangssignal.

+48V +48V Schaltfläche Phantomspeisung (nur bei MIC-Signal)
Diese Funktion aktivieren, wenn das Mikrofon Phantomspeisung benötigt.

Schaltfläche PAD 
Aktivieren Sie diese Funktion, um eine Dämpfung von 16 dB zu bewirken.

Schaltfläche Link/Unlink
Auf diese Schaltfläche klicken, um die Eingangs-/Ausgangssignale zu koppeln oder zu 
entkoppeln.

Verstärkung (nur bei MIC-Signal)
Dient zur Einstellung der Eingangsempfindlichkeit.
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Analoge Ausgänge AES-Ausgänge: Kanal 1 wird inaktiv

Ausgangskanäle

Symbol/
Schaltfläche

Beschreibung

Normal Aktiv

Mute Schaltfläche
Betätigen, um das Ausgangssignal stummzuschalten.

Schaltfläche Link/Unlink
Auf diese Schaltfläche klicken, um die Eingangs-/Ausgangssignale zu koppeln oder zu 
entkoppeln.

Pegelanzeige
Die Pegelanzeige ermöglicht die Überwachung des Signalpegels sowohl am Eingang als auch am Ausgang.

3

2

1 Pos. Beschreibung

1 Roter Bereich: 0 dBFS bis -3 dBFS

2 Gelber Bereich: -3 dBFS bis -18 dBFS

3 Grüner Bereich: -18 dBFS bis unendlich
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4.4.2 Erstellen einer Voreinstellungsseite

Mit Presets können die Einstellungen der Geräte für eine spätere Wiederverwendung gespeichert werden. Presets kön-
nen auch erstellt und gespeichert werden, wenn kein Gerät angeschlossen oder online ist. Nach Einstellung der Parame-
ter kann das Preset als .dap-Datei lokal auf dem Computer gespeichert werden.

	• Menü: File > Create Preset
	• Tastaturbefehl: Strg/Cmd + N

Schaltfläche / 
Bildschirmtext

Beschreibung

CANCEL Schließt das Fenster, ohne den Preset zu speichern.

SAVE PRESET Speichert den Preset als .dap-Datei auf dem Computer.
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Schaltfläche / 
Bildschirmtext

Beschreibung

Choose devices Dient zur Auswahl der Einstellungen eines oder mehrerer Geräte und zum Laden der Presets.
Select all: Dient zur Auswahl aller Geräte in der Liste.
Select none: Es wird kein Gerät aus der Liste ausgewählt.

 Kontrollkästchen: nicht markiert.
 Kontrollkästchen: markiert.

PRESET PREVIEW Vorschaufenster der Einstellungen, die mit dem Preset geladen werden.

CANCEL Schließt das Fenster, ohne den Preset zu laden.

LOAD PRESET Dient zum Laden des Presets mit den ausgewählten Geräteeinstellungen.

4.4.3 Preset-Seite laden

Lädt einen Preset aus einer .dap-Datei auf dem Computer.
	• Menü: File > Load Preset
	• Tastaturbefehl: Strg/Cmd + L



18 Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Produktbeschreibung

Symbol Beschreibung

Warnsymbol.
Zeigt eine Nichtübereinstimmung an.

Fehlpaarung

Das Laden des/der Presets ist fehlgeschlagen. Der Modus des Presets stimmt nicht mit der Betriebsart des Geräts 
überein (z. B. Preset ist im AES-Modus gespeichert, Gerät arbeitet im Analogbetrieb). Weitere Informationen über die 
Betriebsarten und Schaltlogik befinden sich im Abschnitt "4.3.3 Betriebsarten und Schaltlogik des DPRO Adapters" auf 
Seite 11.
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4.4.4 Fenster Reset Devices

Diese Funktion setzt die ausgewählten Geräte auf die Werkseinstellungen zurück. Die Funktion zum Zurücksetzen wird 
im Abschnitt "5.4.8 Gerät zurücksetzen" auf Seite 32 beschrieben.

	• Menü: Device > Reset Device

Schaltfläche / 
Bildschirmtext

Beschreibung

CANCEL Schließt das Fenster, ohne die Geräte zurückzusetzen.

RESET DEVICES Dient zum Zurücksetzen ausgewählter Geräte auf die Werkseinstellungen.
Select all: Dient zur Auswahl aller Geräte in der Liste.
Select none: Es wird kein Gerät aus der Liste ausgewählt.

 nicht ausgewählt.
 ausgewählt

Schaltfläche / 
Bildschirmtext

Beschreibung

Device name Name des ausgewählten Geräts.

Device Firmware Die aktuelle auf dem Gerät installierte Neutrik-Firmware-Version.

Dante Firmware Die aktuelle auf dem Gerät installierte Dante-Firmware-Version.

IP Address IP-Adresse des Geräts im Netzwerk.

FIRMWARE 
UPGRADE

Öffnet ein Fenster zum Upgraden der Neutrik-Firmware auf dem Gerät.

RESET DEVICE Setzt das Gerät auf die Werkseinstellungen zurück.

4.4.5 Fenster About Device (Device Settings)

Dieses Fenster zeigt allgemeine Informationen über das ausgewählte Gerät an.
	• Menü: Device > About Device
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Schaltfläche / 
Bildschirmtext

Beschreibung

AUTOMATIC Das Gerät bezieht die IP-Adresse vom DHCP-Server oder lokal vom Computer.

MANUAL Die IP-Adresse des Geräts kann manuell eingegeben werden.

IP Adress Die über DHCP oder einem lokalen Computer zugewiesene IP-Adresse. Aktiv, wenn 
AUTOMATIC aktiv ist.

Static IP Address Die vom Benutzer eingegebene IP-Adresse. Die markierte IP-Adresse ist aktiv.

New Static IP 
Address

Durch Anklicken des Symbols  kann eine neue statische IP-Adresse eingegeben werden.

REBOOT NOW Dient zum Neustarten des Geräts.

CANCEL Schließt das Fenster ohne jede Änderung.

SET STATIC IP 
ADDRESS

Legt die gewählte statische IP-Adresse fest.

4.4.6 Fenster Network Settings



21Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Produktbeschreibung

Schaltfläche / 
Bildschirmtext

Beschreibung

[Device Name]: 
Current Firmware 
Version X.X

Informationen über die aktuelle Geräte-Firmware.

Select Firmware Dient zur Auswahl der heruntergeladenen Upgrade-Datei.

CANCEL Schließt das Fenster, ohne ein Upgrade der Firmware durchzuführen.

UPGRADE NOW Installiert die Firmware aus der ausgewählten Upgrade-Datei.

Upgrading 
Firmware to 
Version X.X

Der Fortschrittsbalken informiert über den Fortschritt des Firmware-Upgrades.

Firmware upgrade 
completed 
successfully

Information, dass das Firmware-Upgrade abgeschlossen ist. Das Gerät startet nach 
erfolgreichem Upgrade neu.

4.4.7 Fenster Firmware Upgrade

Aktualisiert die Neutrik-Firmware auf dem Gerät.
	• Menü: Device > Firmware Upgrade

Schaltfläche / 
Bildschirmtext

Beschreibung

Software Version Version der DPRO Controller-App.

Version Date Veröffentlichungsdatum der App-Version.

4.4.8 Fenster About Software

Allgemeine Informationen über die App.
	• Menü: Help > About Software



22 Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Bedienung

5  Bedienung

5.1 Vorbereitungen

	T Den DPRO Adapter auspacken.
	T Die Verpackung für einen späteren Transport und die Lagerung aufbewahren.
	T Die Verpackung und den DPRO Adapter auf sichtbare Schäden prüfen.
	T Wenn sichtbare Schäden an der Verpackung und/oder den gelieferten Teilen festgestellt werden, 
den Verkäufer oder einen Neutrik-Vertriebspartner kontaktieren.

	T Unter keinen Umständen ein beschädigtes Gerät verwenden.

5.2 Geräte mit dem DPRO Adapter verbinden

Der DPRO Adapter kann über ein Twisted-Pair-Ethernet-Kabel (CAT5e) mit 1 Gbit/s Standard an ein 
DanteTM-Netzwerk angeschlossen werden. Diese Verbindung ist sowohl für die Datenübertragung 
als auch für die Stromversorgung zuständig. Je nach Kabellänge und Schirmung wird von einer 
Kabelverlegung parallel zu Stromversorgungsleitungen abgeraten. Um den DPRO Adapter von der 
Stromversorgung zu trennen, müssen die PSE bzw. PSEs (Switch oder Injektor) von der Steckdose 
getrennt werden.

Der DPRO Adapter erfordert einen Power-over-Ethernet-Switch oder einen PoE-In-
jektor (802.3 af/at/bt).

	w VORSICHT

Gefahr von Gehörschäden!

Beim Anschließen einer Audioquelle/-senke kann es zu Signalspitzen kommen.
	T Vor dem Anschließen den Signalweg der Peripheriegeräte stumm schalten.

	w VORSICHT

Gefahr von Gehörschäden!

In Folge falscher Anschlüsse können Signalspitzen auftreten.
	T AES/EBU-Signale nicht an Eingang 1 anschließen.
	T Keine Verstärker oder andere analoge Geräte an Ausgang 2 (AES) anschließen, 
wenn an Ausgang 1 (ANA) kein Anschluss vorhanden ist.

Vorderseite Rückseite
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	T Das Gerät je nach gewünschter Anwendung anschließen: 
Analoges Signal: Kanal 1 und Kanal 2 verwenden. 
AES-Signal: Kanal 2 verwenden.

	T Den DPRO Adapter über ein Netzwerkkabel an den PoE-Switch anschließen.
	T Wenn der Switch PoE nicht unterstützt, einen PoE-Injektor verwenden.
	�Die LEDs leuchten auf, sobald der DPRO Adapter über den Schalter oder den PoE-Injektor mit 
Strom versorgt wird.
	�Der DPRO Adapter ist betriebsbereit.
	�Die gewünschte Audioverbindung mit der "DanteTM controller" Software einrichten.

5.2.1 Stromversorgung mit Switch mit PoE-Unterstützung einrichten

Der DPRO Adapter leitet Informationen an den PoE-Switch weiter, die angeben, dass es sich 
um ein Gerät der "Klasse 2" handelt, um eine korrekte Stromversorgung zu gewährleisten.

5.2.2 Stromversorgung mit Switch ohne PoE-Unterstützung einrichten

Audio-Anschluss

Netzwerkanschluss

PRIMARY

Für eine Redundanz der Stromversorgung und Datenübertragung müssen 2 passive PoE-Injektoren 
verwendet werden. Da der Erkennungsvorgang nicht durchgeführt wird, führt das Umschalten 
zwischen primärem und sekundärem Gerät nicht zu einem kurzen Tonausfall. Weitere Informa-
tionen über PoE finden Sie im Abschnitt "7.2 PoE (Power over Ethernet)" auf Seite 41.

Verwenden Sie nicht zwei verschiedene passive PoE-Injektoren (z. B. von verschiedenen 
Herstellern), da dies einen Kurzschluss verursachen und das Gerät funktionsunfähig machen 
könnte.
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Audio-Anschluss

Netzwerkanschluss

5.3 Anwendungen

5.3.1 Redundanter Betrieb

Im redundanten Betrieb werden zwei Kopien aller DanteTM-Informationen (Audio, Taktsignal usw.) 
in getrennten Netzen übertragen, um einen ununterbrochenen Signalfluss sicherzustellen, falls ein 
Netz ausfällt. 

5.3.2 Serienschaltungsbetrieb (Kaskadenschaltung)

Im Serienschaltungsbetrieb werden mehrere Geräte in Reihe geschalten, um die Anzahl der Kanäle 
zu erhöhen. Nur passive Injektoren sind in der Lage, einen konstanten Strom an alle in Reihe ges-
chalteten Geräte zu liefern. Aus Sicherheitsgründen können bei einer Kaskadenverkettung insgesa-
mt 2 Geräte miteinander verbunden werden, wenn sie mit dem Gummischutz (NA-RC) verwendet 
werden. Ohne Gummischutz (NA-RC) an den Geräten können 4 Geräte miteinander verbunden 
werden.

Verwenden Sie für Kaskadenschaltungen nur einen 
PoE-Injektor ohne Klassifizierung.
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5.4 Verbinden von Geräten mit dem DanteTM-Controller

Der DanteTM-Controller ist eine kostenlose Software-Anwendung, die das Weiterleiten von Audi-
osignalen und die Konfiguration von Geräten in einem DanteTM-Netzwerk ermöglicht. Die Einrich-
tung eines DanteTM-Netzwerks ist sehr einfach. Der DanteTM-Controller ermöglicht eine automa-
tische Geräteerkennung, Signalweiterleitung mit nur einem Mausklick und benutzerdefinierbare 
Geräte- und Kanalbezeichnungen.

Die Software kann zusammen mit Tutorials und Anleitungen von der Audinate-Website (www.
audinate.com) heruntergeladen werden.

5.4.1 Aktivieren einer DanteTM-Verbindung

	T Die " DanteTM Controller"-Software herunterladen und 
installieren. (www.audinate.com).

	T Den Computer mit einem Standard-Netzwerkkabel an 
den Switch anschließen.

	T Die "DanteTM Controller"-Software starten.
	T Im Menü Weiterleitung auf die + Symbole der Geräte 
klicken.

	T Die gewünschte Verbindung herstellen.

Der DPRO Adapter wird im "DanteTM Controller" 
standardmäßig als NA2DPRO gefolgt von einem 
Suffix aus den letzten 6 Ziffern der MAC-Adresse 
angezeigt. Dieser Name kann für jedes Gerät im 
DanteTM-Controller angepasst werden.

Die "DanteTM Controller"-Software wird nur zum Einrichten der Audioverbindung (Weiterleitung) 
zwischen den Geräten und zur Konfiguration der angeschlossenen Geräte verwendet.
Die Geräte werden über die DPRO Controller App eingestellt.

5.5 DPRO Controller App

Der DPRO Controller ermöglicht dem Benutzer die Einstellung von Audioparametern, die Überwa-
chung des Gerätestatus sowie das Abrufen, Speichern und Laden von Presets. Die Anwendung ist 
für PC und Mac verfügbar.

Erst den Dante® Controller von Audinate installieren, bevor NA2-IO-DPRO im DPRO-
Controller verwendet wird.

5.5.1 Herunterladen und installieren der DPRO Controller App

Die DPRO Controller App ist kostenlos für PC und Mac erhältlich.
Bitte vor der Installation der App die Systemanforderungen in den technischen Daten durch-
lesen.

	T Die App von der Neutrik-Website www.neutrik.com/en/support/downloads herunterladen.
DPRO Controller  
App-Symbol
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Installation unter Windows
	T Die heruntergeladene .exe-Datei ausführen und den Installationsschritten folgen.
	�Der Installationsassistent erstellt einen Eintrag im Startmenü und eine Verknüpfung auf Ihrem Desktop.

Installation unter OS X
	T Die heruntergeladene .dmg-Datei ausführen und den Installationsschritten folgen.
	�Die DPRO Controller App wird auf dem Computer installiert.

5.5.2 Geräte mit der App verbinden

	T Die Geräte wie vorgeschrieben anschließen.
	T Den DPRO Controller starten.
	�Die Geräte werden automatisch mit dem DPRO Controller verbunden.

5.5.3 Auswahl des zu bearbeitenden Geräts

1

	T In der Liste der angeschlossenen Geräte (1) auf den Gerätenamen klicken.
	�Das ausgewählte Gerät wird mit einem grünen Balken auf der linken Seite markiert.
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	T MIC/LINE umschalten: 
Auf die MIC/LINE Schaltfläche klicken.

	T Aktivieren/Deaktivieren der -16 dB Dämpfung: 
auf die Schaltfläche PAD klicken.

	T Aktivieren/Deaktivieren des Tiefpassfilters: 
Auf die Schaltfläche 80Hz klicken.

	T Aktivieren/Deaktivieren der Phantomspeisung: 
Auf die Schaltfläche +48V klicken.

	T Verstärkung einstellen: 
Den Verstärkungsregler anklicken und geklickt halten und die 
Maus bewegen.

	T Koppeln/Entkoppeln der Eingangskanäle 
Auf die Schaltfläche Link/Unlink klicken.

5.5.4 Einstellen der Eingangsparameter

5.5.5 Einstellen der Ausgangsparameter

	T Kanal stummschalten/Stummschaltung aufheben: 
Auf die Schaltfläche MUTE klicken.

	T Einstellen der Ausgangslautstärke: 
Die Schieberegler-Schaltfläche anklicken und geklickt halten 
und die Maus nach oben oder unten bewegen.

	T Schieberegler auf 0 setzen: 
Strg/Cmd gedrückt halten und auf den Schieberegler klicken.
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5.5.6 Presets

Presets ermöglichen es dem Benutzer, die Einstellungen der mit der App verbundenen Geräte zu speichern.

Preset erstellen
	T Im Menü auf File > Create Preset... klicken oder den Tastaturbefehl Strg/Cmd + N verwenden.
	�Das Fenster Create a new preset erscheint.

	T Je nach vorliegender Anwendung im Dropdown-Menü den Eingangsmodus und den Ausgangsmodus (Keiner, Analog, 
AES) auswählen.

	T Die Parameter festlegen.
	T Auf die Schaltfläche SAVE PRESET klicken, um den Preset als .dap-Datei auf Ihrem Computer zu speichern.
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Preset laden
	T Im Menü  auf File > Load Preset... klicken oder den Tastaturbefehl Strg/Cmd + L verwenden.

	T Eine .dap-Datei auf Ihrem Computer auswählen und auf die Schaltfläche Open klicken.
	�Das Fenster Load Preset erscheint, in dem eine Vorschau des zu ladenden Presets angezeigt wird.

	T Im Dropdown-Menü Ihre Geräte auswählen.
	T Prüfen, ob die angeschlossenen Eingangs-/Ausgangssignale mit dem voreingestellten Modus (ANA/AES) 
übereinstimmen.
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	�Wenn das Laden des Presets fehlgeschlagen ist, erscheint das Fenster Load Preset mismatch.

	T Die Anschlüsse an den Ein-/Ausgängen des Geräts überprüfen: 
Für analoge Signale Kanal 1 und Kanal 2 verwenden. 
Für AES-Signale Kanal 2 verwenden.

	T Versuchen, den Preset erneut oder einen anderen Preset zu laden.
	T Wenn kein passender Preset verfügbar ist, einen neuen Preset erstellen.

Weitere Informationen über die Betriebsarten und Schaltlogik befinden sich im Abschnitt 
"4.3.3 Betriebsarten und Schaltlogik des DPRO Adapters" auf Seite 11.
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	T Um den Preset zu laden, auf die Schaltfläche LOAD PRESET klicken. 
Preset speichern

	T Im Menü auf File > Save as Preset... klicken oder den Tastaturbefehl Strg/Cmd + S verwenden.
	T Einen Dateinamen eingeben und auf die Schaltfläche Save klicken.

5.5.7 Gerät erkennen

	T Das zu erkennende Gerät auswählen.

Option 1:
	T Im Menü Device > Identify device auswählen.

Option 2:
	T In der Gerätestatus-Übersicht die Schaltfläche für die Geräteerkennung  anklicken. 

Option 3:
	T Den Tastaturbefehl Strg/Cmd + I verwenden.

	�Die LEDs des Geräts blinken 10 Sekunden lang.
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5.5.8 Gerät zurücksetzen

Diese Option löscht alle auf dem ausgewählten Gerät eingestellten Parameter. Das Gerät bleibt mit 
der App verbunden. Es gibt zwei Möglichkeiten, das Gerät zurückzusetzen.

Hardware-Reset

Mithilfe des Hardware-Resets werden die folgenden Parameter zurückgesetzt:
	• Wenn MIC aktiv ist: Verstärkung = 0 dB, HPF und Phantomspeisung werden ausgeschaltet.
	• Netzwerk-Einstellungen: Zurücksetzen auf Werkseinstellungen (DHCP aktiviert).
	• Die Stummschaltung der Ausgänge wird ausgeschaltet.

	T Auf der Rückseite des Gerätes die RESET-Taste (1) ca. 5 Sekunden lang drücken.
	�Gerät wird zurückgesetzt.

Software-Reset

Mithilfe des Software-Resets werden die folgenden Parameter zurückgesetzt:
	• Wenn MIC aktiv ist: Verstärkung = 0 dB, HPF und Phantomspeisung werden 
ausgeschaltet.

	• Netzwerk-Einstellungen: Zurücksetzen auf Werkseinstellungen (DHCP aktiviert).
	• Die Stummschaltung der Ausgänge wird ausgeschaltet.

	T Im Menü Device > Reset Device… auswählen.
	�Das Fenster Reset Devices erscheint.

	T Die zurückzusetzenden Geräte auswählen.
	T Auf die Schaltfläche RESET DEVICES klicken.
	�Die Geräte werden zurückgesetzt.

1
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5.5.9 Netzwerkeinstellungen

Die interne IP-Adresse kann in 2 Modi eingestellt werden.

Automatisch
Das Gerät bezieht die IP-Adresse vom DHCP-Server oder lokal vom Computer.

Manuell
Der Benutzer legt die IP-Adresse manuell fest.

	T Den Modus MANUAL auswählen.
	� Eine neue Zeile zur Eingabe einer neuen statischen IP-Adresse erscheint.
	T Auf das  Symbol klicken, um die statische IP-Adresse einzugeben.
	T Auf die Schaltfläche SET STATIC IP ADDRESS klicken.
	T Das Gerät neustarten: 
Dazu auf die Schaltfläche REBOOT NOW klicken.
	�Die statische IP-Adresse wird dem Gerät zugewiesen.



34 Betriebsanleitung- DANTE® Adapter NA2-IO-DPRO | BDA 573 V3 2020/08

Bedienung

5.5.10 Firmware-Upgrade

Mit der Firmware-Upgrade-Funktion in der DPRO Controller-App kann vom Benutzer nur 
die Neutrik-Firmware des Geräts aktualisiert werden. Für das Upgrade der DanteTM Firmware 
bitte den DanteTM Controller verwenden.

	T Das Firmware-Upgrade von der Neutrik-Website www.neutrik.com/en/support/downloads 
herunterladen.

	T In der DPRO Controller-App das zu aktualisierende Gerät auswählen.

Option 1:
	T Im Menü Device > Firmware Upgrade auswählen.

Option 2:
	T In der Gerätestatus-Übersicht die Schaltfläche für die Einstellungen  anklicken.
	�Das Fenster Device Settings wird angezeigt.

	T Auf die Schaltfläche FIRMWARE UPGRADE klicken.
	�Das Fenster Firmware Upgrade wird angezeigt.

	T Die Schaltfläche Choose… anklicken und die heruntergeladene Upgrade-Datei auswählen.
	T Auf die Schaltfläche UPGRADE NOW klicken.
	�Das Upgrade der Firmware des Geräts wird installiert.

	�Während des Upgrades zeigt der Fortschrittsbalken den Fortschritt des Upgrades an.
	�Nachdem das Upgrade abgeschlossen wurde, wird die Meldung Firmware upgrade completed 
successfully angezeigt.
	�Das Gerät wird automatisch neu gestartet.
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5.6 Montageanleitung für das Zubehör

	w HINWEIS

Nur Original-Neutrik-Schrauben verwenden, um Schäden am Gerät zu vermeiden.

5.6.1 Montagehalterungen

Die Montagehalterungen ermöglichen die Montage des Gerätes in Bodenkästen, unter Tischen 
usw.

Lieferumfang
Montage der Montagehalterungen

Die folgenden Werkzeuge werden benötigt:
	O Torx-Schraubendreher (T10)

2 Halterungen 2 Befestigungsschrauben 2 Torx-Schrauben 2 Distanzscheiben

1

	T Den Gummischutz entfernen.

2

	T Eine Halterung, eine Distanzscheibe und eine Schraube 
wie auf der Abbildung gezeigt am Gerät montieren.

	T Die Schraube mit einem Schraubendreher anziehen.
	T Diese Schritte auf der gegenüberliegenden Seite des 
Geräts wiederholen.

3 4

	T Die Fixierschraube wie auf der Abbildung gezeigt 
montieren.

	T Diese Schritte auf der gegenüberliegenden Seite des 
Geräts wiederholen.

	T Die Halterungen je nach Einbausituation in die 
gewünschte Position drehen.

	T Die Befestigungsschrauben fest anziehen.
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5.6.2 Rackblende

Lieferumfang

1 Rackblende

1 2

	T Den Gummischutz entfernen.

	T Das Gerät in die Rackblende einsetzen.
	T Das Gerät mit den vier Schrauben befestigen.

	T Die 4 Schrauben an der Vorderseite des Geräts 
entfernen.

Montage der Rackblende

Die folgenden Werkzeuge werden benötigt:
	O Kreuzschlitz-Schraubendreher

3
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1 2

	T Den Gummischutz entfernen.

	T Das Gerät in den Befestigungsbügel einsetzen.
	T Das Gerät mit der Fixierschraube fixieren.
	T Die Schraube positionieren.

	T Die vorhandenen Schrauben (4 Stk. M3 x 6 mm) 
verwenden.

	T Den Schutzrahmen am Gerät festschrauben.
3 4

5

5.6.3 Bügelhalterung

Montage der Bügelhalterung

Für die Installation von bis zu 2 Geräten auf einem Truss.

Lieferumfang
Montage des Montagesatzes

Die folgenden Werkzeuge werden benötigt:
	O Kreuzschlitz-Schraubendreher

4 Kreuzschlitzschrauben 4 Befestigungsschrauben 2 Schutzrahmen 1 Befestigungsbüel
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6  Nach dem Gebrauch

6.1 Geräte demontieren

	T Die Geräte von den Audioquellen/-senken trennen.

6.2 Transport

	T Geräte und Zubehör stets in der Originalverpackung transportieren.

6.3 Lagerung

	T Wenn die Geräte über einen längeren Zeitraum nicht benutzt werden, die angeschlossenen 
Geräte trennen.

	T Die Geräte stets an einem sauberen und trocknen Ort aufbewahren.
	T Geräte stets vor Schmutz, Staub, Hitze, Feuchtigkeit und Nässe schützen.

6.4 Reinigung und Pflege

	w HINWEIS

Durch eine falsche Reinigung kann das Gerät beschädigt werden!

	T Vor der Reinigung alle Verbindungen trennen.
	T Das Gerät oder Zubehör niemals in Wasser eintauchen.
	T Gerät und Zubehör keinesfalls mit Flüssigkeiten anspritzen.

	T Oberflächen der Geräte und des Zubehörs mit einem weichen, mit milder Seifenlösung leicht 
angefeuchteten Tuch abwischen.

	T Keinesfalls aggressive, lösungsmittelhaltige oder scheuernde Reinigungsmittel verwenden.
	T Keinesfalls raue Materialien (z.B. Reinigungstücher oder -schwämme mit rauer Beschichtung) 
verwenden.

6.5 Wartung und Reparatur

Der DPRO Adapter enthält keine Teile, die vom Benutzer gewartet oder repariert werden können.
	T Den DPRO Adapter nur von einem von Neutrik autorisierten Fachhändler reparieren lassen.

	T Den DPRO Adapter regelmäßig auf sichtbare Schäden am Gehäuse, an den Bedienelementen, 
Anschlüssen, Kabeln und Steckern prüfen.

	T Wenn Schäden festgestellt werden, darf das Gerät unter keinen Umständen verwendet werden.
	T Ein beschädigtes Gerät sofort außer Betrieb nehmen.
	T Defekte Kabel oder Zubehörteile sofort ersetzen.
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6.6 Entsorgen

	T Den DPRO Adapter und das Zubehör gemäß den vor Ort geltenden Vorschriften 
entsorgen.

	T Elektrische Geräte oder elektrisches Zubehör wie Kabel, Stecker, Batterien oder 
Bauelemente unter keinen Umständen über den Hausmüll entsorgen.

	T Die Verpackung und Verpackungsteile gemäß den vor Ort geltenden Vorschriften entsorgen.
	T Bestandteile des Gerätes aus Plastik, Metall und anderen Wertstoffen gemäß den lokal gültigen 
Verordnungen der Wiederverwertung zuführen.
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7  Anhang

7.1 Technische Daten

DanteTM-Spezifikationen

Kanäle 2 EINGÄNGE (Line Level / Mic / AES / EBU) 
2 AUSGÄNGE (Line Level / Mic / AES / EBU)

Unterstützte Abtastraten 44,1 / 48 / 88,2 / 96 kHz

Bit-Tiefe 16, 24 und 32 Bit

Latenzzeit basierend auf Benutzerauswahl 0,25 ms (Dante)

Ethernet-Verbindung 1.000 BASE-T (mit PoE Unterstützung)

Elektrische Spezifikationen

Leistungsaufnahme < 6 Watt

Stromversorgung 1.000 BASE-T (mit PoE Unterstützung) oder 
PoE Injektor (gemäß IEEE 802.3af/at/bt)

Analoger Audio-Eingang

Äquivalentes Eingangsrauschen -128 dBu (67 dB Verstärkung); A-bewertet

Gain Hub (3 dB Schritte) 0 – 67 dB

Max. Eingangspegel +24 dBu (PAD aktiviert)
+8 dBu (PAD deaktiviert)

Eingangswiderstand > 7,5 kOhm, symmetrisch

Frequenzgang 20 Hz bis 20 kHz (± 0,5 dB) 

Dynamikbereich > 112 dB, BW 22,4 kHz, A-bewertet (Eingangsverstärkung = min.)

Signal-Rausch-Verhältnis > 112 dB, BW 22,4 kHz, A-bewertet

THD + Rauschen < 0,005 % (20 Hz bis 20 kHz, +4 dBu)

Übersprechdämpfung -100 dB, benachbarte EINGANG/AUSGANG-Kanäle (Eingangsverstärkung = 
min.)

Analoger Audio-Ausgang

Ausgangswiderstand < 150 Ohm, symmetrisch

Max. Ausgangspegel +24 dBu

Restliches Ausgangsrauschen -88 dBu, A-bewertet

Frequenzgang 20 Hz bis 20 kHz (± 0,5 dB) 

Dynamikbereich > 112 dB, BW 22,4 kHz, A-bewertet

Signal-Rausch-Verhältnis > 112 dB, BW 22,4 kHz, A-bewertet

THD + Rauschen < 0,005 % (20 Hz bis 20 kHz, +4 dBu)

Übersprechdämpfung -100 dB, benachbarte EINGANG/AUSGANG-Kanäle (Eingangsverstärkung = 
min.)
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Mechanische Spezifikationen

Gewicht 0,53 kg / 1,17 lbs

Abmessungen  
(mit Gummischutz)

L = 164 mm (6,4 Zoll)
B = 82 mm (3,2 Zoll)
H = 51 mm (2,0 Zoll)

Abmessungen  
(ohne Gummischutz)

L = 151 mm (5,9 Zoll)
B = 66 mm (2,6 Zoll)
H = 41 mm (1,6 Zoll)

Betriebsumgebung Innenbereich

Betriebstemperatur 0 °C bis +50 °C

Lagertemperatur –40 °C bis +70 °C

App-Anforderungen

RAM min. 2 GB

Bildschirmauflösung min. 1280 x 1024 px

Betriebssystem Windows 7 oder höher
MAC OS X 10.12 oder höher

7.2 PoE (Power over Ethernet)

PoE steht für Power over Ethernet und beschreibt eine Praxis, bei der ein einziges CAT5e Kabel (oder höher) verwendet 
wird, um sowohl Strom als auch Daten in einem einzigen Kabel zu übertragen. 

Einige Vorteile
	• Einfache Einrichtung
	• Länge eines einzelnen Kabels bis zu 100 m
	• Die Verwendung von PoE erfordert aufgrund der geringen Stromlasten keinen zugelassenen Elektriker.
	• Es kann die vorhandene Netzwerkinfrastruktur genutzt werden

7.2.1 Begrifsserklärungen

PD (Powered device) - Gerät, das an eine Stromversorgungseinheit angeschlossen ist und von dieser mit Strom versorgt 
wird.
PSE (Power Sourcing Equipment) - Gerät, das das PD mit Strom versorgt. Dabei kann es sich um einen Netzwerk-Switch 
oder Injektor handeln.

PSE Typen
Im vorliegenden Fall werden nur zwei Arten von PSE-Geräten verwendet.

	• PoE-Switch: ein Switch, der das PD mit Strom versorgen kann. Switches verwenden die PoE-Klassifizierung. 
	• PoE-Injektor: normalerweise ein Gerät mit einem Anschluss für die Stromversorgung von 1 PD. Diese Geräte gibt es 
mit Klassifizierung (aktiv) oder ohne (passiv). Der NPS-30W von Neutrik ist ein passiver PoE-Injektor.

Der Begriff Klasse bezieht sich auf die maximale Leistungsabgabe (siehe Tabelle unten).
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7.2.2 PoE-Standards

Diese Standards sind Teil des allgemeinen Standards IEEE 802.3.
802.3 af - definiert die PoE-Klassen 0-3.
802.3 at - verwendet die gleichen Klassen, führt jedoch zusätzlich die Klasse 4 ein.
802.3 bt - verwendet die gleichen Klassen wie 802.3 af und 802.3 at, führt jedoch zusätzlich die 
Klassen 5 bis 8 ein.

7.2.3 Klassen und Erkennungsvorgang

Die Erkennung wird vom PSE ausgeführt und bestimmt die Bedingungen für die Stromversorgung 
des PD. Sobald das PD und das PSE miteinander verbunden sind, sendet das PSE einen kurzen 
Spannungsimpuls aus, liest den Rückgabewert und stellt die entsprechend Stromversorgung bereit. 
Dies gilt für klassifizierte PSEs (auch als aktive PSEs bezeichnet).
Nicht klassifizierte (passive) PSEs funktionieren wie eine klassische Stromversorgung, daher wird 
keine Erkennung durchgeführt und PSEs liefern eine konstante Stromversorgung.

Klasse Standard Erforderliche Leistung nach PoE-
Klasse für das gespeiste Gerät (PD)

1 IEEE 802.3af 0,44 – 3,84 W

2 3,84 – 6,49 W

3 6,49 – 12,95 W

4 IEEE 802.3at 12,95 – 25,5 W

5 IEEE 802.3bt 25,5 – 40 W

6 40 – 51 W

7 51 – 62 W

8 62 – 73 W
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